





Deneba Software
7400 Southwest 87" Avenue
Miami, Florida 33173

June 24, 1993






Canvas 3.5

Canvas 3.5 contains a variety of new external tools, designed to
improve your Macintosh graphics performance and to take these capa-
bilities across platforms. Along with object creation, special effects, and
professional text editing tools, Canvas 3.5 includes a tool for importing
documents from Canvas for Windows, the version of Canvas created
for use with Microsoft® Windows™. Canvas 3.5 brings Canvas for the
Macintosh in line with Canvas for Windows.
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New features in Canvas 3.5

Canvas 3.5 contains the following external tools. Each tool is explained

under a separate heading in this chapter.

- Bézier Text is an enhanced version of the Canvas 3.0 version of this
tool. It creates composite objects that have integral character cen-
ters, using TrueType and PostScript Type 1 fonts.

« Bind is a professional version of the Canvas 3.0 version of this tool.
It offers increased precision and sensitivity to curve fluctuations
when text or objects are bound along a path.
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Blend Objects is an enhanced version of the Canvas 3.0 tool. It offers
advanced features for creating blends between objects and object
groups, including greater control over the distribution of blended
objects.

Canvas Windows 1/0 is used to import documents created in the Win-
dows version of Canvas, Canvas for Windows.

Concentric Circles creates concentric circles and ovals, for which you
can specify the number of circles and the spacing between them.

Envelope is used to stretch, bend, and warp the bounding rectangle
of draw objects or text objects. The objects conform to the new
Envelope shape, creating exciting effects.

Extrude gives a cut-from-granite look to draw or text objects by gen-
erating a 3-D effect composed of draw objects.

Fine Kern provides fine kerning options that can be customized.

Fractals applies fractal effects to draw objects. You can adjust the
amount of wiggle and the angularity of fractal shapes.

Group Composite creates a composite group of Bézier curves from
selected objects.

Layer Stamp places a dynamic object in a document, showing the
name of the document’s active layer. The object updates if the lay-
er's name changes.

MacroWindow shows the current MacrObjects in a floating window.

Name Stamp places a dynamic object in a document, showing the
document’s name. The object updates if the document’s name
changes.

Pressure Pen lets Canvas use pressure-sensitive drawing tablets to
draw Bézier curves of varying thicknesses. It also simulates the
effect of a pressure-sensitive pen using the mouse.

Smart Lines links objects with lines that automatically adjust when

you move the objects. Smart Lines are useful for illustrations such as
circuit diagrams and organizational charts.

Sounder adds sound objects to Canvas documents, slide shows, and
QuickTime movies.
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Spiral creates Bézier curves in spiral shapes. You can specify the
number of revolutions in the spirals you draw.

Style Sets is used to save settings for text in a style set. You can then
apply the style set to text in a document.

Text Utilities is an enhanced version of the Canvas 3.0 Text Utilities
tool. It is used to flow text to create page layouts for documents
such as newsletters and brochures.

Time Stamp places a dynamic object in a document, showing the
current date and time. The object automatically updates when the
date and time change.

Tool Loader loads external tools that did not load at start-up.

n Canvas 3.5, the Tool Box icons, Layer palette icon, and Information

Manager are shaded a light gray when the Window color in your Color
control panel is set to a color other than Black & White. When you
select a tool in the Tool Box, the background changes from light gray
to dark gray.
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If you are sending a Canvas 3.5 document to a service bureau, the ser-
vice bureau must open the document in Canvas 3.5 or a later version
of Canvas. If there are external tool objects, such as concentric circles

and stamp objects, or if there are composite groups, such as Bézier text

and extruded text, the corresponding external tools must also be
loaded for the objects to display correctly.

Canvas 3.5
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The Bézier Text external tool makes the Create Béziers command in
the Text menu available. This command transforms text characters in a
TrueType or PostScript Type 1 printer font to Bézier curves.

This new Bézier Text external tool improves on the original tool by
creating composite groups when converting text to Bézier curves. With
this new tool, letters such as O, P, and Bare kept complete rather than
being separated into interior and exterior objects. The centers of such
letters remain hollow, allowing background areas to show through.

Using the Create Béziers command
To change text into Bézier curves:
1. Select the text you want to change into Bézier curves.

You can select text characters or an entire text object. If you select
characters, Canvas changes a copy of the text into Bézier curves.

2. From the Text menu, choose Create Béziers: Hollow or Filled.
Canvas transforms the selected text into Bézier curves.
You can drag the new Bézier text away from the original, if necessary.
I User Tip: Canvas must be on the same hard drive as the TrueType or
PostScript Type 1 printer font to create Bézier text.

You cannot apply the Create Béziers submenu options to a text object
with a TrueType font that has the Outline or Shadow style.

Using the Create Béziers submenu

The Create Béziers submenu offers two options for turning text into
Bézier curves.

Create Béziers » GG
Filled

Hollow creates an outline of the text with Bézier curves using the
default pen pattern, pen size, dash style, pen mode, and no fill pattern.



Bind

Bind

Filled converts the text to Bézier curves filled with the default pen pat-
tern, using a zero pen size and the default pen mode.

CANVAS CANVAS

Hollow Filled

After text is converted, you can leave it grouped to edit as a whole or
ungroup it and edit the new objects as you would any Bézier curve.
You can change pen and fill patterns, foreground and background col-
ors, and other properties. You can also edit the shape of an object after
placing it in edit mode.

To apply a gradient fill to Bézier text created with this version of the
Bézier Text tool, you must first ungroup the text into individual curves
and change the curves’ fill patterns to solid background.

The Bind external tool makes the Bind Text command and the Bind
Group option of the Special Effects submenu available. The Bind Text
command, explained below, fits text to an object. The text and the
object can be modified as a unit or individually. For information on the
Bind Group option see Chapter 16, “Adding effects,” in the Canvas 3.0
manual.

The Bind external tool is a professional version of the original Canvas
3.0 tool. It has increased precision for better spacing and sensitivity to
curve fluctuations.
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Using the Bind Text command

You can bind text to any draw object, including polygons and Bézier
curves. You can also bind text to the bounding rectangles of paint
objects. To bind text to an object:

1. Select the text and the object you want to bind it to.

Text can hold a curvef ——— Selected lext object
«— Selected object

2. From the Text menu, choose Bind Text.

Canvas binds the text to the selected object.

How text binds to an object depends on its justification. In the follow-
ing illustrations, the apex of each triangle is that triangle’s origin.

. Left and Full justified text bind starting at the object’s origin.

Left justified Full justified

- Right justified text binds backward from the object’s origin.

- Center justified text binds so that it is centered on the object’s path.

Right justified Center justified

Canvas 3.5
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Blend Objects

You can change the font, size, and other properties of a selected
bound text object. To change the properties of individual bound text
characters, double-click the text object and highlight the characters you
want to edit.

Bind Text command modifier keys

Text characters bind to an object in the direction the object is drawn.
You can change how text you bind to an object is positioned by using
modifier keys with the Bind Text command.

« To pick the point on a selected object where text will begin binding,
hold down the Command key (38) and choose the Bind Text com-
mand. The pointer changes to a crosshair with text that changes
depending on the justification of the text. Click where you want the
text to start binding; the text follows the object’s path until it ends.

For Left and Full justified text the pointer reads Pick Left Edge. The
text binds starting at the point you click.

For Right justified text the pointer reads Pick Right Edge. The text
binds backward, starting the point you click.

For Center justified text the pointer reads Pick Center Point. The text
is centered on the point you click.

« To change the direction in which text binds and the side of the
selected object to which text binds, hold down the Shift key and
choose the Bind Text command.

+ To pick the starting point and to change the direction in which text
binds and the side of the selected object to which text binds, hold
down the Command (38) and Shift keys and choose Bind Text.

The Blend Objects external tool makes the Blend command in the
Object menu available. The Blend command blends one or more
objects, creating a series of intermediate objects.

The Blend Objects external tool adds several new features to the origi-
nal Canvas Blend command. The objects you select for the blend can
be individual draw objects or object groups. The new Blend Obijects

Canvas 3.5 1
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external tool also offers additional blend rates and options for position-
ing the intermediate objects.

Using the Blend command

The Blend command blends the shapes, colors, fill and pen patterns,
and pen sizes of two or more selected draw objects. Blending creates a
series of objects between the selected objects. You can specify the
number and position of shapes in the blend, select the color method
and rate for the blend, and pick the points from which the objects in
the blend are defined.

Objects are blended from back to front. The object that you drew first
is the back object and the one that you drew last is the front object.
You can change the order of objects before you blend them with the
options in the Arrange submenu.

The Blend command is enabled when you select two or more draw
objects or object groups. To create an object blend:

1. Select the objects you want to blend.
2. From the Object menu, choose Blend (38-Option-B).
The Blend Specifications dialog box opens.
3. Select the settings you want for the blend, and click OK to proceed.

If you selected the Point to Point option, you need to click a point
on each object.

Canvas creates the blend between the selected objects.



Blend Objects

Using the Blend Specifications dialog box
You can select a blend’s settings using the text boxes and pop-up
menus in the Blend Specifications dialog box.

Blend Specifications aill]

sh . —Colors

R IEI Method: [ RGB Dalues |
Start %: D Rate: [ Constant v
Stop %: ~Object Positions—————————————

: tant
CiBoink tapolp) | TOie: | Deustan ]

Shapes specifies how many objects, from 1 to 999, Canvas creates
between each of the selected objects.

When you change the number in the Shapes text box, the values in the
Start % and Stop % text boxes change accordingly.

Start % and Stop % specify a range for the properties, including colors,
and positions of intermediate objects in a blend. For example, a Start %
of 50 assigns object properties starting with the properties halfway
(50%) between the selected objects, and positions the first blend object
halfway (50%) between the selected objects.

Colors
The options in this part of the dialog box affect the blending of fore-
ground and background colors and properties of the selected objects.

Method affects the blending of foreground and background colors.

- RGB Values or CMYK Values creates RGB (Red, Green, Blue color
system) or CMYK (Cyan, Magenta, Yellow, Black color system)
blends, respectively, from the colors of the back object to those of
the front object. The command reads RGB Values unless a selected
object has a CMYK color in it, in which case it reads CMYK Values.

- HSV Values creates HSV (Hue, Saturation, Value color system)
blends from the back object’s colors to the front object’s colors.

Canvas 3.5 9
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- Palette Colors cycles through the colors in the current palette to cre-
ate blends from the back object’s colors to the front object’s colors.

Rate affects the blending of the properties of the selected objects. If the
selected objects have different pen and fill patterns, colors, or pen
sizes, the intermediate objects in the blend are assigned the patterns,
colors, and pen sizes that fall between those of the selected objects in
the appropriate palette.

w | | | | EEENZY =]
F/MREEEE N s

Front object’s fill pattern
Back object’s fill pattern —

| |
Back object Front object

- Constant evenly blends the properties of the selected objects.
- Accelerating emphasizes the properties of the back object.
- Decelerating emphasizes the properties of the front object.

- More Middle emphasizes the average of the properties; there are
fewer intermediate objects that strongly resemble either object.

- More Ends emphasizes the properties of both objects; there are
fewer intermediate objects that average both object’s properties.

Back object Front object

Constant

Decelerating
More Middle

More Ends




Blend Objects

Object Positions
Rate affects the position of the intermediate objects in the blend.

- Constant positions the intermediate objects evenly between the
selected objects.

- Accelerating places more intermediate objects near the back object.
- Decelerating places more intermediate objects near the front object.

- More Middle places more intermediate objects midway between the
selected objects.

- More Ends places more intermediate objects near the selected
objects than in the area between them.

coment (O D OCOCEK XK S E A5
Accelerating @m@@ {:\’7 i::( i:; {:}{/\:}
Decelerating O O O O C {:}Qﬁm
More Midde (™) (7) Oomm?ﬁ%{}

weos (X000 O O QTHEIR

Point to Point blends two selected draw objects according to a point
you specify on each. This option is enabled when only two objects are
selected. After you click OK and the dialog box closes, click a point on
each object. The point you select on the back object blends toward the
point you select on the front object.

)

Points selected for blend Objects blended Point to Point
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To change the orientation of intermediate objects in a Point to Point
blend, hold down the Option key as you click the points.

)

Points selected for blend Objects blended Point to Point
with Option key held down

0K blends selected objects according to your settings and closes the
dialog box.

Cancel discards your changes and closes the dialog box.

Canvas Windows 1/0

When the Canvas Window 1/O external tool is active, the Canvas™

Windows file format is available in the Open dialog box’s File Format
pop-up menu. This option is used to open files created in Canvas for
Windows, the version of Canvas compatible with Microsoft Windows.

Opening a Canvas for Windows file

To open a file created in Canvas for Windows:
1. From the File menu, choose Open.

The Open dialog box appears.

=) HOUSE »
D FLOOR1.CVS <{r| = Macintos...

O FLOOR2.CVS
Eject

Desktop

H0kE

&
File Format: [ Canvas™ Wind... |
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Concentric Circles

2. From the File Format pop-up menu, select Canvas™ Windows.

3. Using the directory, locate the file you want, and click Open.

The format of the active document appears in the title bar before
the name of the document.

WinCanvas:FLODR2.CUS BE|

B

User Tip: If you import a Canvas for Windows file that contains a pic-
ture object, the picture object appears as a box with an X in it and
will not print. However, the information is still there and will con-
tinue to display and print in Windows.

Canvas for Windows is fully compatible with Canvas Macintosh, ver-
sions 2.0 or later. If you will be opening a Macintosh Canvas file in
Canvas for Windows, save the file in the Canvas™ file format.

Concentric Circles

When the Concentric Circles external tool is active, the Concentric Cir-
cles tool in the Object Tools palette and the Concentric Circle Manager
are available. The Concentric Circles tool draws concentric ovals and
circles, and the Concentric Circle Manager determines the number of
circles the Concentric Circles tool creates and the spacing between the
circles.

Using the Concentric Circles tool

The Concentric Circles tool uses the default pen and fill patterns, fore-
ground and background colors, pen size, and pen mode to draw con-
centric ovals and circles. The number of circles in a concentric circle
and the space between them depend on the settings in the Concentric
Circle Manager.

@:

To draw a concentric circle:

1. Select the Concentric Circles tool from the Object Tools palette.

Canvas 3.5 13
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The pointer changes to a crosshair.
2. Drag in your document to draw the concentric circle.

The concentric circle appears as you move the pointer.

3. Release the mouse button when the concentric circle is the shape you want.

Using modifier keys
You can use the following modifier keys when drawing or editing a
concentric circle:

« To constrain a concentric circle to a circular rather than oval shape,
hold down the Shift key and draw or drag a corner selection handle.

» To draw or resize a concentric circle from its center, hold down the
Option key as you drag.

Editing concentric circles

You can use the Concentric Circle Manager to change the number of
circles in a concentric circle and the space between them. To open the
Concentric Circle Manager, double-click the concentric circle object or
select it and choose Edit Concentric Circles (38-E) from the Object
menu. The changes you make affect only the selected object.

You can also edit concentric circles as you would any draw object.

Using the Concentric Circle Manager

The Concentric Circle Manager specifies the number of circles the Con-
centric Circles tool creates and the space between them. To open the
Concentric Circle Manager, choose Concentric Circles from the Manag-



Envelope

ers submenu in the Edit menu, or double-click the Concentric Circles
tool icon in the Object Tools palette.

Concentric Circle Manager

Number of Circles: ‘Z]
Space Circles every:
0 is Equidistant E

Number of Circles sets how many circles a concentric circle object has.

Space Circles Every sets the distance in pixels, from 0 to 100, between
each circle in a concentric circle. If you type 0, the circles in a concen-
tric circle are evenly spaced; their spacing depends on the object’s size

0K saves your settings and closes the dialog box.

Cancel discards your changes and closes the dialog box.

Envelope

The Envelope external tool makes the Envelope command in the
Effects menu available. This command offers ways to transform the
shape of draw objects and text objects by warping and stretching the
envelope (bounding rectangle) that contains them.

Using the Envelope command

To use the Envelope command:
1. Select the object you want to modify.
2. From the Effects menu, choose Envelope.

A submenu of options opens.

Envelope ld Straightline  %°L
Single Cusp ®°S
Double Cusp ®°D
Bezier %®°C

3. Choose an Envelope option from the submenu.

Canvas 3.5 15
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Handles appear, showing the envelope around the selected object.

s
P st

4. Drag a handle to change the shape of the envelope.

You can drag the handles in any direction to change the shape of
the envelope. An outline of the envelope follows the pointer as you
drag a handle.

Envelope generates a new path between the point you drag and its
adjacent points. The type of path Canvas generates is determined by
the Envelope option you chose in step 3. When you drag a point,
both adjacent paths are affected.

5. Release the mouse button when the outline is the shape you want.

The object shape changes to fit the altered envelope. You can con-
tinue to modify the shape by repeating steps 4 and 5. When you fin-
ish, press the Enter key.

Enveloping produces its most effective results on medium and large
objects. Small objects tend to produce overly distorted results. Also,
you cannot envelope a text object with a TrueType font that has the
Outline or Shadow style.

Using the Envelope submenu options

You can select one of four options from the Envelope submenu,

Straight Line (88-Control-L) generates straight lines between the point
you drag and its adjacent points.

C o> >

Straight Line envelope Point dragged Enveloped object




Envelope

Single Cusp (88-Control-S) generates either a concave or convex curve
between the point you drag and its adjacent points.

) (A~

Single Cusp envelope Point dragged Enveloped object

Double Cusp (38-Control-D) generates “S™ curves between the point
you drag and its adjacent point.

\/

Double Cusp envelope Point!dragged Enveloped object

Bézier (38-Control-C) makes the handles around the envelope act the
same as anchor points on a Bézier curve. You can select an anchor
point, drag its tangent line, break the tangent line to change the anchor
point into a cusp, and drag to move the anchor point.

AN' CANVAS

Anchor point
Bézier envelope Enveloped object

Editing an enveloped object
After you envelope an object, you can continue reshaping the object’s
envelope.

1. Select the enveloped object, and open the Effects menu.
The Envelope command reads Edit Envelope.

2. Open the Edit Envelope submenu and choose an Envelope option.

The object’s envelope appears around the object.
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3. Drag a handle to continue reshaping the envelope.
The object’s shape changes to fit the altered envelope.
4. When you finish, press the Enter key.

To continue reshaping a draw object’s envelope with the last envelop-
ing option used, you can double-click the enveloped object. The
object’s envelope appears around the object and you can drag a han-
dle to continue modifying it.

Extrude

The Extrude external tool makes the Extrude command in the Effects
menu available. This command creates three-dimensional objects from
text and draw objects. You can use the Extrude Object dialog box to
control the placement and scaling of extruded objects.

Using the Extrude command

The Extrude command uses a selected object’s fill pattern, pen pattern,
pen size, dash style, pen mode, and foreground and background col-
ors to create extrusions. To extrude an object:

1. Select an object you want to extrude.

2. From the Effects menu, choose Extrude (88-Option-E).
The Extrude Object dialog box opens.
3. Adjust the settings in the dialog box, then click 0K.

Canvas creates the extrusion behind the original object.

18  Canvas 3.5



Extrude

If you selected the Use Mouse checkbox in the Extrude Object dia-
log box, the pointer changes to show an outline of your object.
Click where you want the extrusion to end. To size the object at the
end of the extrusion, drag. When you release the mouse button,
Canvas creates the extrusion.

Selected object  Pointer positioned for extrusion Extruded object

You cannot extrude text with TrueType fonts that have the Outline or
Shadow style. Also, if you extrude an object that has lines that cross
over each other (such as a star), it is best to set its fill pattern to N. Oth-
erwise, the extrusion might appear uneven.

User Tip: You can give an extruded text object a hollow outlined
appearance by changing its foreground color to white and its back-
ground color to a dark color.

Using the Extrude Object dialog box

The Extrude Object dialog box is used to specify the size and orienta-
tion of extruded objects. The dialog box opens when you select an
object and choose the Extrude command from the Object menu.

Extrude Object ==
Percentage
[[Juse Mouse

i
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X Offset determines the horizontal displacement, in the current ruler
units, of the extrusion. A positive number directs the extrusion to the
right; a negative number directs the extrusion to the left.

Y Offset determines the vertical displacement, in the current ruler units,
of the extrusion. A positive number directs the extrusion down; a neg-
ative number directs the extrusion up.

Percentage determines what percentage of the selected object’s size the
end of the extrusion will be.

Use Mouse places the end of the extrusion at a point you click or drag
from when the dialog box closes. When you select Use Mouse, the
other settings in the dialog box are dimmed.

0K extrudes the object according to your settings and closes the dialog
box. If Use Mouse is selected, a pointer appears, and you can place
and size the end of the extrusion.

Cancel discards your settings and closes the dialog box without extrud-
ing the object.

Fine Kern

When the Fine Kern external tool is active, the Tighten Fine, Loosen
Fine, and Configure Fine Kern options are available in the Kerning
submenu. These commands are used to adjust the space between let-
ters in a text selection.

Using the Fine Kern commands

You can use Tighten Fine and Loosen Fine to apply custom kerning
amounts to text. You can set the kerning amount for these options
using the Kerning Specifications dialog box. The default setting for the
Fine Kern commands is 0.25 points.

20 Canvas 3.5



Fine Kern

T very Tight

Tight

v Normal
Loose
Uery Loose

Tighten ¥l
Loosen ®i-

Tighten Fine  #=s{t« )
Loosen Fine  ®=s{i— Fine Kern options
Configure Fine Kern...

Tighten Fine (38-Option-Shift-¢-) reduces the space between letters in a
text selection.

Loosen Fine (35-Option-Shift-—>) increases the space between letters in
the text selection.

You can apply the Fine Kern options to selected text or use them as
your default setting.

+ To apply the Fine Kern options to text, highlight the text or select
the text object and from the Text menu choose Kerning: Tighten
Fine or Loosen Fine. The text kerns accordingly.

+ To set the default Kerning setting, make sure no objects are selected
and from the Text menu choose Kerning: Tighten Fine or Loosen
Fine. Subsequent text objects you create are kerned accordingly.

Configure Fine Kern opens the Kerning Specifications dialog box, which
sets the kerning amount for the Tighten Fine and Loosen Fine options.

Using the Kerning Specifications dialog box

The Kerning Specifications dialog box specifies the kerning amount for
the Fine Kern commands. To open this dialog box, from the Text
menu, choose Kerning: Configure Fine Kern.

Kerning Specifications KK
Kerning -
Amount: pis
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Kerning Amount is the amount by which the Tighten Fine and Loosen
Fine options in the Kerning submenu change the spacing between let-
ters. Tighten Fine reduces the space between letters by this amount;
Loosen Fine increases the space between letters by this amount.

0K saves your settings and closes the dialog box.

Cancel discards your changes and closes the dialog box.

The Fractals external tool makes the Fractalize option available in the
Special Effects submenu. Fractals are mathematical transformations that
simulate the patterns in natural forms, such as the edge of a coastline
or mountain range. Fractalize opens a dialog box you can use to apply
a fractal pattern to draw objects.

Using the Fractalize option

You can transform most draw objects using the Fractalize option. If
you convert text to Bézier curves, the letters can be fractalized. When
you apply a fractal affect to a draw object, the object becomes a poly-
gon. You cannot apply the Fractalize command to dimension objects
or Smart Lines.

Original object Object with fractal effect

To apply a fractal effect to a draw object:

1. Select the object to which you want to apply a fractal effect.

2. From the Effects menu, choose Special Effects: Fractalize.
The Fractal Specifications dialog box opens.

3. Type the Wiggle and Density values you want in the text boxes.

These settings are explained under the following heading, “Using
the Fractal Specifications dialog box.”
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